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What is Lineform?

Drawing, art and design are everywhere. Fliers, post-
ers, logos, sketches, floor plans, Web sites, t-shirts, and 
magazines. To communicate your idea, drawing and 
design are key.

Lineform is designed so you can have fun drawing. It 
provides a simple and easy interface to complex draw-
ing tools. Powerful features such as artistic strokes and 
Boolean operations combined with the great interface 
let you forget about the interface and enjoy drawing.

If you want to do any drawing, from simple logos to 
complex designs, then Lineform is the ideal program for 
you.

Lineform is a vector drawing tool, similar to Illustrator, 
Freehand, and CorelDraw. Lineform works with lines, 
curves and shapes to create drawings that both look 
amazing and are entirely editable.
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T H E  I N T E R F A C E

Lineform’s interface revolves around a document win-
dow that displays the canvas and objects being edited. 
Objects on the canvas are manipulated by the mouse or 
keyboard and can be altered from the inspectors that 
float above the document window.

The Toolbar

Each document in Lineform has its own toolbar at the 
top of the window. This toolbar shows which tool you 
are currently using and allows quick access to other 
tools. 
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Selection – Selects and moves objects.

Editing – Alters curves and lines.

Brush – Draws smooth lines.

Pen – Draws lines and Bézier curves.

Rectangle – Draws rectangles and squares.

Oval – Draws ovals and circles.

Text – Draws text boxes.

Zoom – Zooms in and out of the canvas.

Drag – Moves around in the canvas.

Dropper – Picks up styles from objects in the canvas.

The tools can also be selected by pressing the digits 0-9 
or their corresponding shortcut keys. The toolbar can 
be customized to contain several handy functions, like 
combining and Boolean operations.

To customize the toolbar, choose Customize Toolbar... 
under the View menu.

The Status Bar

Below the toolbar is the status bar. This shows hints 
and information about what action you are currently 
performing. It shows the possible modifier keys for any 
action in blue, and it shows the current size or state of 
any transformation of objects being modified.
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Inspectors

Lineform uses inspectors that “float” 
above all the other windows. These pro-
vide access to object and canvas proper-
ties. The inspectors can be minimized or 
hidden and snap to each other. Inspec-
tors can be toggled on and off in the 
Inspectors menu.

The Fill, Stroke, and Effects inspectors 
affect the appearance of objects in your 
document. The Grid, Layout, and Layers 
inspectors affect the canvas itself. Finally, 
the Filters inspector provides advanced 
options to apply effects to objects.

Media Browser

The Media Browser is accessed from the Inspectors 
menu. It provides access to images and pictures stored 
in iPhoto or elsewhere on your computer. You can 
search for and drag images into any Lineform docu-
ment.
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Keyboard

Several keyboard shortcuts and modifiers are used in 
Lineform. These are mentioned in this manual where 
they are relevant. The Shift, Option, and Command (⌘) 
keys affect most operations. The Escape key cancels the 
current action.

M A N I P U L A T I N G  T H E  C A N V A S

  Zoom (z)

Click with the zoom tool to magnify the canvas, and Op-
tion-click to zoom back out. To zoom in on a particular 
area of the canvas, click and drag the zoom tool around 
the area of interest.

The canvas can also be magnified to a specific zoom 
level by selecting a level from the pop-up menu in the 
bottom right of the document window, or zoomed to fit 
from the View menu.

Press Control-Space bar once to select the zoom tool 
temporarily, allowing you to zoom in quickly on part of 
the canvas. After zooming, the tool reverts to the previ-
ously selected tool. 
  

   Drag (g)

The drag tool is used to move around the canvas. To 
move the visible part of the canvas, click and drag with 
this tool.

Temporarily select the drag tool by holding down the 
Space bar.
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C R E A T I N G  O B J E C T S

The brush, pen, rectangle, oval, and text tools are used 
to create line and shape objects. When one of these 
tools is selected, click and drag on the canvas to create 
new objects. Newly created objects use the style from 
the inspectors.
 

  The brush tool (b)

The brush tool is used to draw smooth curves and paths, 
and is ideal for drawing smooth arbitrary shapes and 
tracing pictures.

The Bézier paths are automatically smoothed; if a more 
accurate path is required, the Option key can be held to 
limit the smoothing.

  The pen tool (p)

The pen (Bézier) tool creates a sharp node for each click, 
building an arbitrary shape out of a series of nodes. To 
create smooth nodes and curves, click and drag the pen 
tool.

Double-click on the canvas or a node to complete the 
line, or press Escape to cancel it. To cancel only the last 
segment of an unfinished line, press the Delete key.

Click on the initial node to close the path being drawn, 
creating a loop. To continue drawing path nodes, hold 
the Option key. Hold the Shift key to limit the line and 
curve drawing to 15° angles.
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Both the pen tool and the brush tool allow new paths to 
be drawn onto either the beginning or end of existing 
paths. When either tool is selected, nodes appear at the 
ends of selected paths that are available to append to. 
Drawing from one of these nodes automatically ap-
pends the new path to the existing path. This allows 
both tools to be used to draw different parts of the 
same shape.
  

  The rectangle (r) and oval (o) tools

The rectangle and oval tools draw their respective 
shapes. Hold the Shift key to restrict the new shape to a 
1:1 aspect ratio, creating either squares or circles. Hold 
the Option key to create shapes from the center.
  

  The text tool (t)

The text tool can be used in two modes. It can be 
dragged to create a text region, or by simply clicking 
and then typing, the region created will be the same 
size as the text typed.

The text tool does not create a special object: it is just 
a handy shortcut. The same effect can be achieved by 
creating a rectangle with a text fill style.
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M A N I P U L A T I N G  O B J E C T S

  Selecting objects

Select an object using the selection tool by clicking on 
the object. Multiple objects can be selected by Shift-
clicking or by dragging a selection around the objects 
you want to select.  The selection tool starts a drag-se-
lection when clicking and holding down the mouse but-
ton in empty part of the canvas.  The ~ key will toggle 
between current scale and position of the mouse.
To add to the current selection, hold the Shift key 
while dragging the new drag-selection. Objects can be 
deselected by Shift-clicking on them after they’ve been 
selected. 

Objects with no fill can be selected by clicking on the 
stroke line or drag-selecting the object.

Selected objects are drawn with a transparent halo 
around them. The primary object is drawn with a light 
green halo and all other selected objects are drawn 
with a light blue halo. Press the Tab key to change the 
primary object. This cycles through all the currently 
selected objects.

The primary object is the object displayed in the 
inspectors when more than one object is selected. It 
is useful for some operations like Boolean subtract or 
align, where these operations alter the selected objects 
relative to the primary object. 

To select only objects that are entirely within the selec-
tion region you are dragging, hold the Option key as 
you drag. This is useful for selecting small objects or 
objects that are on top of each other.
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You can select all the objects on the canvas with Select 
All from the Edit menu, or deselect all objects with 
Select None.

Often, one object will obscure other objects hidden 
below, and these are impossible to select normally. 
Command-click to select these objects.

The first Command-click selects the top object like a 
regular click.  Each subsequent Command-click will 
select the object below the current selection. Several 
Command-clicks will cycle through the objects below 
the mouse in order, eventually returning to the topmost 
object.

Moving, scaling and rotating

Once some objects have been selected, nine handles 
should appear around the selection. These handles 
manipulate the selection. The Control key toggles the 
mode from scale to rotate/skew. 

You can:

• Move objects by dragging on the them or the 
dragging the white center drag handle. Constrain 
the movement vertically or horizontally by hold-
ing the Shift key.
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• Create a copy of the objects by holding the Option 
key while dragging.

• Scale the objects by dragging any of the blue and 
green edge handles. The blue corner handles scale 
the objects both horizontally and vertically. The 
green edge handles scale only in one axis.

The Shift key constrains the corner scaling to 
preserve the original height/width aspect ratio. 
Holding the Option key transforms the objects 
from the center.

To rotate or skew an object by its handles, hold the Con-
trol key. Now you can:

 
• Rotate the objects by dragging the orange corner 

handles. Hold the Shift key to constrain to rotation 
15° angles.

• Skew the objects by dragging the yellow edge 
handles.  Hold the Shift key to constrain the skew-
ing to 15° angles.

Hold down the Command key while manipulating 
objects to stop their fill style from changing. This allows 
you to clip pictures easily. Command-drag scale handles 
the to scale the shape but not the picture. Command-
dragging also allows you to increase the size of a text 
box without changing the size of the text. 
 
In a similar manner, holding the Z key down while ma-
nipulating objects stops the stroke style of the objects 
from changing size. This allows you control whether to 
scale a line with the drawing or separately.
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The following diagram shows the difference between 
scaling the fill or stroke.

Transform Inspector

The Transform inspector makes it easy to the manipu-
late width, height, layout, rotation, and skew of an 
object. Click grid control in the upper left to set the 
origin of the transformation.  The Shape, Stroke and Fill 
checkboxes enable or disable transformations for the 
object’s respective elements.

Transforming with the keyboard

Lineform also allows you to use the arrow keys to nudge 
objects. Objects are moved 1 pixel by default or 10 pix-
els if the Shift key is held. You can also nudge objects at 
the current zoom level by holding the Option key.

Align and distribute

An object can be aligned both horizontally and verti-
cally with the edges and centers of other objects. Com-
mands for alignment can be found in the Objects menu. 
The selected objects are aligned relative to the primary 
selected object.
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Objects can also be distributed horizontally and verti-
cally from the Objects menu. The distributing com-
mands space the selected objects out so that the size of 
the gaps between the objects are the same.

Flip

Objects can be flipped around their center horizontally 
and vertically. Objects are flipped from the Objects 
menu.

L A Y E R S  A N D  Z - O R D E R

Z-order refers to the order in which objects are drawn, 
i.e., which objects are drawn on top of others. In Line-
form, you can change the ordering of objects with the 
Bring to Front and Send to Back commands in the 
Objects menu. These move the selected objects all the 
way to the bottom or top of the stack.

You can also raise and lower objects one step at a time 
with the Bring Forward and Send Backward com-
mands. These will move objects up or down, respective-
ly, as long as the next layer is visible and unlocked.
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Each layer contains its own objects. The layers also have 
their own z-order, and can be rearranged in the Layer 
inspector by dragging. An arrow to the left of the name 
highlights the currently active layer; all new objects will 
be created in this layer. To make a layer the active layer, 
click in the left-most column by that layer.

Each layer can be toggled visible/invisible and locked/
unlocked with the checkboxes in the last two columns.
Hiding individual layers sometimes makes it easier to 
concentrate on the remaining visible layers. Locked 
layers are visible but not editable, which is useful when 
editing objects stacked on top of each other.

Layers are created and deleted by the + and – buttons, 
and can be merged together with the Merge button in 
the Layers inspector. Layers are named by double click-
ing their names and editing.

G R O U P I N G  A N D  C O M B I N I N G

Several objects can be grouped into a single object. A 
group behaves like a single object when it is manipu-
lated. Grouping objects is a useful way to keep objects 
together, for example keeping text positioned over an 
object.

Objects can be grouped together with the Group com-
mand in the Object menu. This creates an new group 
from the selected objects. The Ungroup command 
reverses the grouping of selected groups, separating 
out their components.

Objects within groups retain their separate styles and 
shapes. A different way of combining objects together 
is to use the Combine command. Objects combined 
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together are merged into one object. The combined 
objects lose their separate style. Combining objects is a 
good way to create shapes with holes.

A group can be edited easily by double-clicking the 
group or clicking the Edit Group… button in the Fill 
inspector. When a group is being edited, double-click 
outside the group or select a layer to finish editing the 
group. When a group is being edited it is displayed 
without and effects applied to it and everything else is 
dimmed out.

Groups do not have stroke or fill styles like other objects 
but they can have effects. Thus it is possible to use a 
group to combine several objects together before a 
drop shadow or applying a transparency. Above-left, 
two objects have a drop shadow effect, and the result 
looks ugly because the drop shadows are drawn sepa-
rately on top of each other. Above-right, the objects are 
grouped together and the group has a drop shadow 
effect, which results in one single drop shadow for the 
combined objects.
 
Groups are also useful to clip objects. Enable Clip to Top 
Path in the Fill inspector to enable clipping for a group. 
All the objects inside a group are then clipped to the 
topmost path in the group. If the topmost object has a 
text fill then the group is clipped to the bounds of the 
text.
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Combining
 

Above, two rectangles are combined together. The re-
sulting object takes on the style of the primary selected 
object. This is useful for creating shapes with holes or 
making bigger shapes where you want the different 
parts to have the same style.

Separate Paths splits the parts of composite objects 
out again. Split out objects will always be Bézier paths, 
so rectangles lose the ability to change their corner 
radius.

S T Y L E

The style of an object determines how it is drawn. Each 
object can have its own style specifying the fill, stroke 
and effects. Fill specifies how the center of the object is 
drawn, the stroke specifies how the outline of the object 
is drawn, and the effects specify shadowing and how 
the object is composited onto the page.

When there are no objects selected, the stroke, fill, and 
effect palettes show the current tool style. This is the 
style used when creating new objects. Set the tool style 
to what you want to create many objects with the same 
style.

The dropper tool transfers styles between objects. Click 
on an object with the dropper tool to pick up that ob-
ject’s style. The style is applied to the currently selected 
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objects or to the tool style. The individual components 
of the style can be picked up with the dropper tool by 
holding the Shift, Option, and Command keys, which 
pick up the fill, stroke, and effects respectively.

F I L L

In Lineform there are five fill styles you can apply to 
objects from the Fill inspector: None, Solid, Image, 
Gradient, and Text. A fill style is chosen from the pop-up 
menu in the top-left of the inspector.

The fill of an object, image, gradient, or text is usu-
ally transformed with the object when it is resized or 
changed. Sometimes this is not the behavior wanted. 
Hold the Command key as you resize and alter the 
shape to allow the fill to remain unaltered. With this 
technique, you can crop pictures or expand the size of 

the text box without altering the text.

To reset the fill, use the Reset Fill Transform command 
in the Objects menu. This will reset any alteration that 
has been applied to the fill, such as the rotation of an 
image.
 
The content of the inspector is dependent on the type 
of fill that is selected. Selecting None simply does not fill 
the object, leaving the object completely transparent.
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Solid
 
Solid fills the object with a solid color. This color can 
have an opacity setting, allowing both opaque and 
transparent objects as extremes.

Image

An Image fill draws an image inside the object. The im-
age is clipped to the object’s shape and can be clipped 
to arbitrary shapes. The slider in the inspector controls 
the opacity of the image. The Choose… button provides 
an open dialog for picking an image, and images can 
also be dragged onto the image preview in the inspec-
tor.

Images can be clipped easily by holding the Command 
key as you drag a scale handle.
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Gradient
 
A Gradient fill creates a linear or radial smooth transition 
between two or more colors. The palette provides a hor-
izontal preview and a sequence of color swatches. The 
color swatches can be edited by clicking on them and 
can be dragged around by clicking above the swatches 
on the gradient preview.  To add additional colors, click 
underneath the gradient preview. To remove a color 
swatches drag it away from the gradient preview.

The Position button provides an interactive way to 
change the location and direction of a gradient. Click 
the Position button to begin editing the gradient, then 
drag the gradient around inside the object as you see fit. 
Click elsewhere on the canvas or press any key to stop 
positioning. The nodes can also be dragged around to 
alter the gradient position.

Hold the Shift key while dragging to limit the angle of 
the gradient to 15°. Hold the Option key while dragging 
handles on a radial gradient to allow the setting of the 
individual position without affecting the other handles.
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Text
 
A Text fill allows any shape to contain text. The padding 
and hyphenation of each text fill is set from the inspec-
tor. To edit the text, double-click the object and type 
away. To resize the text object without resizing the text, 
hold the Command key as you resize.

              

The background fill check box fills the object with a 
plain background color if it is required for the text. The 
above 8s shows text accurately filling a complex shape, 
using a blue background fill, an artistic stroke and a 
drop shadow. The text is fully justified: the left-hand 8 
shows the unhyphenated text, while the right hand 8 
shows the text fill with maximum hyphenation.

S T R O K E

Strokes are applied to objects in the Stroke inspector, 
similar to the Fill inspector. There are three options: 

Unhyphenated Hyphenated
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None, Solid, Artistic, and Text.

Solid applies a solid color to the line drawn. In the 
inspector, the color, thickness, and style of the line can 
be set.

Ends can be (left to right) Butt, Round, or Square.

Corners can be set to Mitre, Round, or Bevel.

Lines can also be dashed and this can be set from the 
Dashes pop-up menu.

Arrows

Arrows can be placed at the beginning or end of any 
line. This is useful for drawing diagrams and charts. Each 
arrowhead can be sized relative to the line size and can 
be morphed to the line shape.

Notice how some of the arrows are morphed. This can 
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be applied to either arrow and can make the arrows 
look much more natural and professional.

Artistic strokes

Artistic strokes are an expressive way to draw vector 
objects. The strokes remain fully editable, and provide a 
richness in appearance that vector objects often lack.
With artistic strokes you can add a bit of flare to normal 
drawing:

Or you can let yourself free to draw art:
  

This quick sketch of a snail was drawn with a tablet, 
making use of the brush tool. Layers were used to build 
up the snail using different artistic strokes with transpar-
ency to achieve the final image. On the right you can 
see the “skeleton” of the snail, this is what it looks like 
without artistic strokes.

Text

Text strokes allow placing text on a path. This can be 
any shape or size. Text is typeset out along the path 
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from beginning to end, and paths that contain multiple 
segments have text typeset along each segment in turn. 
The text is edited inside the Stroke palette. It is scaled 
with the line thickness and a baseline offset can be 
specified to move the text perpendicular to the line.

By using kerning it is possible to correct the compres-
sion and extension of the text that happens at sharp 
corners. Changing the text baseline alters the text 
layout. A baseline that centers the text over the line can 
eliminate some of the compression and extension.

E F F E C T S

 

Effects change how an object is drawn or composited 
onto the canvas. It is possible to control the object’s 
opacity, blend mode, and shadow through the use of 
effects.

Opacity controls how transparent an object is. Especially 
useful is the ability to control the opacity of groups, as it 
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controls the opacity of the group as a whole.

Blend modes specify how the colors of objects should 
be mixed. Blend modes are extremely powerful com-
positing modes but also fairly complex. To understand 
how blend modes work it is probably best to experi-
ment with them. The above screenshot shows a brush 
blended with different modes. (From top to bottom 
the blend modes are: Normal, Lighten, and Difference.) 
Blend modes are extremely effective when combined 
with artistic strokes to add extra depth to an object or 
image.

Drop shadows are a simple effect that adds a lot of 
depth to simple objects. A drop shadow can be applied 
to any object in Lineform. Shadows are added to objects 
in the Effects inspector. The radius (how fuzzy the 
shadow is) of the shadow and its color and position are 
also set from the inspector.

F I L T E R S

Filters allow more complex effects, ranging from blur-
ring and color adjustment to halftones, to be easily 
applied to objects, while retaining the ability to edit the 
objects.

Lineform provides a powerful set of filters, based on 
Apple’s Core Image technology. Using Core Image al-
lows many effects, which are impossible with pure vec-
tor objects, to be achieved. For example, filters make it 
simple to create a Gaussian blur of an object, as shown 
below. The same objects are shown on the left without 
filters applied and on the right with filters.
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Filters are controlled through the Filter inspector.

At the top of the Filters inspector are three controls, 
from left to right: whether filters are enabled, the resolu-
tion at which the filters are applied, and an action but-
ton to add new filters. Below these controls is the stack 
of currently applied filters, which can be individually 
minimized, disabled, deleted, and re-ordered. Each filter 
also has its own parameters that can be set.

Many filters are available, and it is worth spending some 
time experimenting and exploring the possibilities. The 
filters are categorized by type as: Geometry Adjustment, 
Distortion Effect, Blur, Sharpen, Color Adjustment, Color 
Effect, Stylize, Halftone Effect, Tile Effect, Generator, 
Gradient, Composite, and Transition. To add new filters, 
click the top-right button in the inspector. To delete 
filters once they have been added, click the X button in 
the right of the filter title-bar.

The filters are applied in order from top to bottom. They 
filters can be re-ordered by dragging the gray title bar 
up or down to move the filter above or below other 
filters. The order of the filters can often have a large 
impact on the final result.
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Filter resolution

Because filters are, by necessity, bitmap operations that 
work at the pixel level, the resolution that the filters 
are applied at makes a difference to how they look. 
Lineform endeavors to keep the filters as independent 
of resolution as possible, however it does not provide 
complete resolution independence.

Each object can be set to have a resolution of 72, 144, 
or 300dpi, the lowest being screen resolution and the 
highest being good for printing. For print it is usually 
best to make use of higher resolution filters, but it’s 
worth experimenting, as some filters with very gradual 
transitions, such as the Gaussian blur, often work well at 
low resolutions. Low-resolution filters are faster to draw 
and take up much less memory.

Bitmap images included in Lineform are optimized to 
have filters applied at their native resolution. This is only 
the case when the filters themselves are resolution-in-
dependent, such as color adjustment, and the image 
object does not have a stroke. This allows filters like 
color adjustment to be applied to images at their native 
resolution and at faster speeds.

E D I T I N G  O B J E C T S  I N  D E P T H

Objects can be edited and altered in different ways. The 
most flexible and useful way to edit objects is to use the 
Edit tool. This allows shapes to be changed and altered 
in any fashion wanted. Once the edit tool is selected, 
nodes appear on the object you are editing. The type of 
nodes depends on the type of object—rectangle and 
oval shapes have different nodes, for example.
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Lineform provides several different ways to begin edit-
ing objects. The simplest is to select the edit tool from 
the toolbar. Any objects that are selected will become 
editable. The Return or Enter keys also toggle between 
the selection tool and the edit tool. It is possible to hit 
Return repeatedly to switch modes depending on what 
you’re doing.

Lastly, it’s also possible to double-click to start editing. 
A double-click acts like a normal selection click, except 
that it starts editing. Thus a double-click can select 
objects to add and remove from editing, just as clicking 
does with the selection tool. The same modifiers affect 
the selection. The Shift key allows objects to be added 
and removed from editing, the Option key selects only 
objects fully within the selection, and the Command key 
allows the selection of objects below the top object. A 
double-click-drag is also possible. These are effective 
both in and out of edit mode.

The double-click selection provides a simple mirror of 
the standard selection tool, and is a very effective way 
of quickly editing the objects you want.

Text objects work slightly differently. Double-clicking a 
text object or pressing return when one is selected will 
begin editing its text. The object itself can be edited by 
selecting the edit tool or by editing it at the same time 
as other objects. 

Rectangles and Ovals

Rectangle and ovals are different from other shapes. 
They are editable in different ways, providing easy 
methods to alter the shapes. If further editing is needed, 
these shapes can be converted into Bézier shapes. This 
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is done with the Objects > Convert > To Bézier menu 
command. Once a rectangle or oval is converted to a 
Bézier shape it is editable in any way. 

Editing a rectangle allows a rounded corner to be set 
and the rectangle to be scaled in its original axes. The 
cyan nodes above are used to scale the rectangle along 
its width and height. The small purple node sets the 
radius of the rounded corner.

An oval is edited in a similar fashion. Two small control 
nodes allow the oval to be set to an arc or pie. If the 
mouse is dragged inside the oval it when dragging a 
control node the oval becomes a pie. If the mouse is 
dragged outside the oval, it becomes an arc. Hold the 
Shift key to force the angles to be constrained to 15° in-
tervals. Ovals are drawn when the two control nodes are 
close. You can prevent this by holding the Option key.

Bézier paths
 

The shape above is being edited, and the squares and 
circles represent the nodes of the shape. These nodes 
specify the shape and can be altered. In the above ex-
ample there are two blue nodes and three pink nodes. 
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Square nodes represent a line segment of the shape and 
the circle nodes represent curve segments. Above the 
smaller purple circles connected to some of the nodes 
are control handles that affect the shape of the curve. 
These control handles only appear on selected nodes 
that are adjacent to a curved segment of the shape.

Nodes work in a similar fashion to objects. Clicking on 
nodes or dragging around them selects the nodes. Hold 
the Shift key to add or remove nodes from the selection. 
The Command key selects nodes from underneath, al-
lowing access to nodes on top of one another.

Once nodes are selected they act in a similar way to 
objects. Dragging moves them, and holding the Shift 
key limits the movement to horizontal or vertical. They 
can also be nudged using the arrow keys in the same 
fashion as objects.

Control handles can be dragged but not selected. Each 
curve node has two control handles, which are automat-
ically aligned. Hold the Option key as you drag a handle 
to move the handles independently. Hold the Shift key 
to constrain the handles to 15° angles. Hold the Com-
mand key to keep the control handles at a constant 
angle as you drag them.

Deleting nodes removes them from the shape; the 
shape is joined up between where the nodes were 
removed. You can delete the selected nodes by pressing 
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the Delete key.
 

Changing nodes to lines (above left) alters the shape so 
that the nodes selected are now lines and not curves. 
This and the other editing functions can be accessed 
from the Objects menu or the contextual pop-up menu. 
The reverse (above right), changing nodes to curves, 
converts any selected nodes to curve nodes. Initially this 
will look the same until you drag the control handles.
To add a node at any point in a Bézier path without 
altering its shape, Option-click at the point in the path 
where you want to place the new node.

There are three extra editing commands: duplicate, 
connect, and cut. Duplicate creates two nodes on top of 
one another. This is useful for adding in extra nodes and 
detail into shapes. Connect joins nodes together within 
the same object. Finally, cut breaks the shape at the 
nodes selected, creating multiple segments.

Boolean operations

Boolean operations are a way of combining two or more 
objects together. The resulting object is created from a 
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Boolean (yes/no) combination of the selected objects 
and takes the style of the primary object.
 
The Union Boolean operation combines two or more 
overlapping shapes into one larger shape, consisting of 
the outer contour of those shapes. 

The Subtract Boolean operation removes or subtracts 
the shape of the selected objects from the primary 
object. In the case above, the orange rectangle is the 
primary object. If the circle were the primary object, the 
resulting object would look like the blue pie below.
 

Using the Intersection Boolean operation results in a 
shape that consists of the overlapping area(s) of the se-
lected objects. If the objects do not overlap, an Intersec-
tion is the same as deletion.

The XOR Boolean operation creates a shape where one 
of the selected objects was but not both. If more than 
two objects are selected, XOR creates a shape where 
an odd number of objects overlap. The same effect can 
be achieved by simply combining the objects together. 
However, XOR creates a new shape with new control 
points that allow editing. 

Outline

Outline converts the outline of the text or objects into 
a path. This creates an outline that can then be edited, 
filled, and manipulated.
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The above shows a rounded rectangle with a gradient 
fill (left) and the result of outlining the rectangle with 
the same fill applied (right). Before outlining, setting a 
gradient stroke is impossible.

There are many other possible uses of outlining, such 
as drawing walls in a floor plan, creating logos out of 
text, and using Boolean operations on artistic strokes. 
The image above shows text that has been outlined and 
then edited to join the T and L and rotate the INE and 
drawn with an artistic stroke, which gives it a pen drawn 
look. A background that has some outlined artistic 
strokes subtracted from it and some flames, which are 
the union of more artistic stroke outlines.

T H E  C A N V A S  I N  D E P T H  &  E X P O R T I N G

Rulers, guides and grid

Lineform provides several methods of aiding accurate 
positioning of objects and shapes. Rulers allow accurate 
measurement of distance, horizontally and vertically. 
Guides can be added to both rulers—these draw pink 
lines across the drawing area that objects automatically 
snap to.
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Guides can be easily used to align objects, size objects, 
and create objects with accurate sizes. Guides can be 
hidden or cleared from the View menu.

 A grid provides a uniform set of guides that objects can 
snap to throughout the document. The grid size, steps, 
and color are all set from the Grid inspector. A grid is 
useful for drawing many different things including 
technical drawings, floor plans, and typesetting layout. 
The grid can be set to any major spacing size with minor 
spacing or steps. The color and drawing properties of 
the grid can also be altered from the Grid inspector. 
Pixel Align aligns the grid lines in the center of pixels 
so that bitmap drawings along grid lines are not anti-
aliased.

Page layout
 

The Layout inspector sets the size of the canvas in 
number of pages. Changing the actual page size, for 
example to A3, is done in the page setup dialog box. 
To access this either select Page Setup… from the File 
menu or click the button inside the Layout inspector. 

The layout panel also allows the canvas margins to be 
changed—useful if drawing to the exact size of the 
paper, however most printers will not print to the edge 
of paper.  To use a specific document size, uncheck the 
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“Size in pages” option.

CMYK preview

Printers and screens use different methods of creating 
color. Screens use an additive combination of red, green, 
and blue (RGB). Printers mostly use a subtractive com-
bination of cyan, magenta, yellow, and black (CMYK). 
Because of the difference in how colors are created it is 
possible to show colors on screen that cannot usually 
be printed. This is disappointing if you have spent a long 
time getting the colors right.

      
 
To avoid this problem Lineform provides a CMYK pre-
view. It is toggled on and off from the View menu. This 
provides a clearer idea of how the drawing will appear 
when printed out. Above shows two screen shots of a 
composition, the left hand screen shot is the normal 
view of the document, the right hand shot shows the 
CMYK preview of the same document. Notice how the 
bright blues and reds and more muted in the CMYK 
preview. This is closer to what will be printed on a CMYK 
printer.

RGB CMYK preview
(note: these images will appear the same in a printed version of this manual)
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Outline view

Outline view renders all shapes as outlines, allowing 
easier selection and editing of overlapping and complex 
drawings. It is toggled on and off from the View menu. 
In outline mode, shapes are rendered as outlines, with-
out any effects or fill. The composition of the Lineform 
logo can be seen on the next page. The artistic strokes 
composited on top of the hands, which cannot be seen 
normally, can be seen as outlines.
 

Export

It is possible to export objects from a document to both 
vector and bitmap file formats. To export objects, select 
the objects then use Export... command in the File 
menu. Objects can be exported to BMP, EPS, JPEG, PDF, 
PNG, and TIFF file formats. It is also possible to specify 
the exported transparency and resolution.

EPS, PDF, and SVG are vector formats and are resolution-
independent. Use these formats if the exported file will 
be printed.

PNG and TIFF are the only bitmap formats that support 
transparency, and PDF is the only vector format that 
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supports transparency.

SVG

SVG is a modern XML-based standard for vector-based 
artwork that is independent of resolution. Lineform 
supports SVG as both an import and export format. SVG 
support is growing in many places like web browsers, 
and also provides a good intermediary format between 
Lineform and other programs.

Lineform’s support for SVG provides comprehensive 
support for the basic SVG standard. This table summa-
rizes Lineform’s SVG W3 test suite compliance:

�����

���

�����������

�������

�����

�������

��������

��������

�����

���������������

���������

������

���������

����

����������������������������

���������������������

�������������������

�����������������

���������������



36

AppleScript

AppleScript support is built into Lineform. If you need to 
extend or compliment Lineform’s abilities with addi-
tional features or automation, then it is simple to do so 
using AppleScript.

For help on using AppleScript, load Lineform as a dic-
tionary in Script Editor.

S U P P O R T

For technical support with Lineform please visit 
Freeverse on the Web:

www.freeverse.com/support

Installation & Registration
To install Lineform, drag the Lineform application from 
the CD or disk image to your Applications folder.  You 
may then eject the CD or disk image volume.

The first time you run Lineform it will ask you to register. 
Click Enter Serial Number if you installed from a CD, or 
Enter Code if you are registering a download.

Enter your name, e-mail address, and registration code.  
The code can be found on the cover of this printed 
manual, or in your confirmation e-mail from Freeverse.

Note:  You must be connected to the Internet for reg-
istration.  Once you are registered you do not need 
to be on-line.

Copyright © 2006 Freeverse Software. All rights re-
served.
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